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[image: ]		

SYRACUSE UNIVERSITY
INSTITUTIONAL REVIEW BOARD
Full Board Review or Expedited Review Application
Check which type of review is requested:
[bookmark: Check387]|_|	Expedited Review- One signed copy of my application for expedited review.
Expedited review covers research that involves only minimal risk procedures. See Standard Operating Procedure 012. Link - SOP-012-Expedited for guidance.
[bookmark: Check386]|_|	Full Board Review- One signed copy of my application for full board review.
Includes research that cannot be reviewed using the expedited process involving more than minimal risk to the participant and requires review by the full IRB. See Standard Operating Procedure 013. Link - SOP-013-Full-Board for guidance.

Application Checklist to be completed by the researcher to confirm the following:
|_| All questions on the application have been answered.
|_| The application has been signed by the investigator/faculty advisor and when appropriate, the student.
|_| Copies of all appropriate, consent and/or assent documents (written, electronic, or oral consent script) are included.
       |_| Copies of any research instruments (surveys, questionnaires, interview questions, etc.) are included.
|_| Copies of all recruitment tools (flyers, emails, posters, newspaper ads, etc.) are included.
|_| All required appendices, including a list of references are included.
|_| Copies of other IRB approvals or letters of cooperation are included. When the investigation is to be carried out in cooperation with another institution or with an investigator at another institution, a letter indicating the willingness of the institution to cooperate in the study must be included with the proposal.
[bookmark: Check384]|_| The principal investigator/faculty member and student/research staff have completed the appropriate Link - Collaborative Institutional Training Initiative (CITI) Web-based Training Program for Human Subjects required by SU.* 
|_| All students/research staff or any other individuals listed in the application who will have direct contact with participants and/or identifiable human participant data have completed the appropriate Link - Collaborative Institutional Training Initiative (CITI) Web-based Training Program for Human Subjects required by SU.*
* Submission of CITI Training Certificate is required only if CITI training was completed at another institution.
I/We assure the IRB that the following statements are true: All information provided in this form is correct. I have evaluated this protocol and determined that I have the resources necessary to protect participants, such as appropriately trained staff, necessary facilities, and equipment. I will seek and obtain prior written approval from the IRB for any modifications including changes in procedures, investigators/research staff, consent forms, questionnaires, surveys, etc. I will promptly report any unanticipated problems that may occur in the course of this study. I will report any significant findings which may affect the risks and benefits to participation. I will not begin my research until I have received written notification of final IRB approval. I will comply with all IRB requests to report on the status of my study. I will maintain records of this research according to IRB standards. If any of the above conditions are not met, I understand that approval of this research may be suspended or terminated.

Faculty Member/Principal Investigator
[bookmark: Text81]Signed__________________________________________   Date:       
[bookmark: Text80]Name (typed):      
Student/Research Staff 
[bookmark: Text82]Signed: ___________________________________________ Date:      
[bookmark: Text83]Name (typed):      
[bookmark: OLE_LINK1][bookmark: OLE_LINK2]
This application must be typewritten, and all questions must be answered. To complete form, tab to each field. Incomplete forms will be returned to the investigator for additional information. Outdated applications will not be accepted for review.
 
To edit the content of the form/unprotect the document as follows:
  Microsoft Office Users
  Unlock Document:
1. Open the Document, Click the Enable Editing box and/or select the View Tab and select Edit, on the Ribbon across the top choose the Review Tab>Click on Restrict Editing (Image of Paper/Lock)>Select box for Stop Protection (at the very bottom of the page). Leave the side bar open until you have completed your edits. 
 Protect Document:
1. Once your edits to the document have been completed, to protect or re-lock the document 
please ensure the following boxes are checked on the right hand side: 
1. Formatting restrictions [Limit formatting to a selection of styles],
2. Editing restrictions [Allow only this type of editing in the document:], drop down to second option Filling in Forms
3. Start enforcement click the box Yes, Start Enforcing Protection.
Click OK with no password entered at the prompt.

To check spelling/grammar, please unprotect the document as follows:
  Microsoft Office Users
  Unlock Document:
1. Open the Document, Click the Enable Editing box and/or select the View Tab and select Edit, on the Ribbon across the top choose the Review Tab>Click on Restrict Editing (Image of Paper/Lock)>Select box for Stop Protection (at the very bottom of the page). Leave the side bar open until you have completed your edits. 
1. Look for the Editor icon (Image of pencil with three dashes) under the Home tab on the far right hand side. Click the Editor icon to begin the spell check process.
 Protect Document:
1. Please repeat steps listed above under edit content. 

1. Protocol Information
[bookmark: Text84]     Title of Protocol:       
Principal Investigator Eligibility: Visiting professors, adjunct professors, post-docs, Ph.D. students, graduate students, or undergraduate students are not eligible to be the Principal Investigator (P.I.) on research protocols. Only faculty at the assistant, associate, or full professor level, academic, research, or professor-of-practice faculty, assistant, associate, full teaching faculty, research fellow, department chair/dean, or administrative staff with the position of director or higher may serve as the Principal Investigator (PI) or Co-Investigator (Co-PI). If you have any questions regarding this Syracuse University institutional policy, contact the IRB office at E-mail - orip@syr.edu  or Phone - 315.443.3013 for guidance.
Principal Investigator/Faculty Member Information  
	[bookmark: Text85]First Name:       
	[bookmark: Text86]Middle Initial:      
	[bookmark: Text87]Last Name:      

	Title:      

	[bookmark: Text88]Department:      
	[bookmark: Text89]College:      

	[bookmark: Text90]Campus Address:      

	[bookmark: Text91]Campus Phone :      
	[bookmark: Text92]Fax :      

	[bookmark: Text93]Email:       
	[bookmark: Text94]Cell Phone (optional):      


Note: Only research staff members, including student researchers, should only be listed in Section 1 of the application if they will have a primary role in the research. All other student/research staff/team members should be listed in Section 6-3. 
Student/Research Staff Information			
|_|NA
	[bookmark: Text95]First Name:      
	[bookmark: Text96]Last Name:      

	[bookmark: Check437][bookmark: Check438][bookmark: Check439][bookmark: Text167]|_| Graduate Student  |_| Undergraduate Student  |_| Other:      

	[bookmark: Text97]Department:      
	[bookmark: Text98]College:      

	[bookmark: Text99]Local/Campus Address:      

	[bookmark: Text100]Local/Campus Phone:      
	[bookmark: Text102]Fax:      

	[bookmark: Text101]Email:       
	[bookmark: Text103]Cell Phone (optional):      



2. Funding Information
2.1. Will/has the research been submitted as a grant or contract proposal?		|_| No    |_| Yes
  Will/has the research been submitted through OSP?					|_| No    |_| Yes
  If yes, who is the proposed sponsor and what is the title of the proposal submitted to OSP?
[bookmark: Text104]		  Sponsor:      
[bookmark: Text105]		  Title:          

2.2. Is this research approved for funding and/or is funding for this research pending?	|_| No    |_| Yes (indicate below)
	|_| Internal Funding (check all that apply):
	|_| Departmental Funds 
	 |_| Personal Funds
	|_| Gifts

	[bookmark: Text109] |_| Other, specify:      


|_| External Funding (list all that apply and insert additional rows if needed):
	Agency/Sponsor
	Funding Mechanisms

	[bookmark: Text110]     
	|_| Grant    
	|_| Contract

	[bookmark: Text111]     
	|_| Grant    
	|_| Contract




2.3. Is this research to be conducted as faculty research?  		|_| No    |_| Yes
2.4. Is this research to be conducted as graduate student research? 	|_| No    |_| Yes (specify below)
For a masters thesis						|_| No    |_| Yes			
		 	For a doctoral dissertation 		      			|_| No    |_| Yes
			|_|  Other purpose (explain):      
2.5. Is this research to be conducted as undergraduate student research? |_| No    |_| Yes (specify below)
 This research will be conducted as part of a course requirement:
|_|  It is a student project designed as a systematic investigation that will lead to generalizable       knowledge. This may include Capstone, Honors, SOURCE Thesis, or other student work generated as a result of this research that will be displayed on the SU website, shared at workshop/conference, or shared outside of the classroom and/or Syracuse University community in any capacity. 
OR
	 	  |_|  It is a student project designed solely to fulfill a course requirement. 
Student projects involving human participants that are conducted solely to fulfill course            requirements and to receive a course grade and will not be shared outside the classroom and/or the Syracuse University community do not require IRB review. For additional information please consult: Link - Student-Projects
2.6    |_|  Other purpose. Any other purpose than those listed above for this research should be explained here.          
                     

NOTE REGARDING APPLICATON PREPARATION: When there is more than one researcher listed in the protocol as part of the research team, please avoid the use of pronouns such as I, me, we, our, etc., or references to “the researcher, researchers, research team, and/or members of the research team” or the use of similar terminology. Instead, all such references should include the names of the members of the research team listed in either Sections 1 or 6 of the protocol application as appropriate. 

3. Study Rationale 
3.1. Using every day, non-technical language, describe the goal of this proposed research including purpose, research question/s hypothesis, etc. From your description, the IRB should be able to determine how this proposed study adds to existing knowledge in the field and judge the risks and benefits to the research participants. The IRB does not need a copy of your entire research study proposal, please do not include it here. Most researchers can provide an adequate description of the goal of their proposed research in two to three paragraphs; this does not need to be a lengthy description. 
[bookmark: Text115]     
3.2 A reference list citing relevant background information must be provided as an appendix with this application. 

4. Methods
4.1.  Provide a detailed description of what participants will be asked to do; including the time commitment for participation and lay descriptions of any technical terms or procedures. In your description, include complete descriptions for each participant group (if there is more than one),  all methods of data collection and all possible venues you plan to use to conduct this research. If you will use more than one methodology and include more than one participant group, each must be described separately.
	        

4.2. Describe how you will have sufficient time to conduct and complete the research. Provide a brief timeline describing your plan to conduct and complete the research as proposed beginning with recruitment, including time points of data collection, data analysis, and  publication/presentation.
[bookmark: Text114]      
4.3. Surveys, interviews, questionnaires will be conducted:
		|_|  N/A Data Analysis Only
[bookmark: Check415]		|_|  No  (Skip to 4.4)    
[bookmark: Check436]		|_|  Yes  Copies of the finalized versions of all research instruments including surveys, questionnaires, 
		  interview/focus group guide questions etc. must be provided as separate appendices, not draft,     
                            sample, and/or example versions. The IRB cannot make a determination as to the level of risk to 
                            the participants without the finalized versions of all research instruments (i.e.-the actual research   
                            instruments that will be presented to participants). Citations and/or links to the instrument cannot 
                            be accepted.

4.4. Community Based Participatory Research (CBPR) is described as research that is conducted as an equal partnership between traditionally trained "experts" and members of a community. Is this research categorized as CBPR? 
|_| No. (Skip to 4.5)
[bookmark: Text169]|_| Yes. Please explain:      
4.4.1.  In CBPR research studies, the community participates fully in all aspects of the research process including conception, design, and analysis. 
With this in mind, describe how you plan to engage community members in your research study:
[bookmark: Text170]  	     
4.4.2.  Describe how you plan to provide community members with appropriate training for human subjects’ research? Include in your description what training will be provided. 
[bookmark: Text171]	     

4.4.3.  Describe your plan to disseminate research findings with members of the community throughout the course of your study.
[bookmark: Text172]     
4.5. Will this research be conducted by SU investigators in foreign countries?
|_| No. (Skip to 4.6)
|_| Yes. An International Research Form must be completed and submitted with this application. 
              Link - International Research Form

4.6. Will human bio-samples be collected (i.e.-salvia, blood, urine, etc.)?
|_| No. (Skip to Section 5)
|_| Yes. If yes, contact Environmental Health and Safety Services at E-mail - ehss@syr.edu for additional 
               requirements. Note: This research will not receive IRB approval until documentation from the    
  Institutional Biosafety Committee is provided. 

4.7. Will this research involve genetic testing?
[bookmark: Check434]|_| No. (Skip to Section 5)
[bookmark: Check435]|_| Yes. A Genetic Research Form must be completed and submitted with this application. Link - Genetics

5. Performance Site Information
5.1. Describe how you will have adequate facilities to conduct your research. Include in your description where each aspect of your research as described in Section 4.1 will be conducted whether it will be conducted in-person or remotely. This includes data collection, data analysis, and data storage (i.e.-on campus using campus facilities/classrooms/offices, off-campus-using home/private offices, public spaces, space at an organization/agency, Internet research, and/or a combination of locations).
     	

5.2. List all Performance Sites Other than SU (insert additional rows if needed).
(This applies when a SU investigator collaborates with a non-SU investigator or institution and/or is allowed space within an outside agency/organization to conduct the research. Sites that have IRB’s must be contacted by the researchers at the time of application to ensure compliance. Please list and provide contact information for each performance site. Each site listed will require either an IRB determination letter (i.e., deferral to the SU IRB, approval, exemption, or IRB review not required because the institution’s role in the research does not constitute human subjects research) and/or a letter of cooperation. The letter must be on official letterhead signed by the person in authority. 

	Check all that apply
	Name of Performance Site 
(list all participating sites below)
	IRB Approval and/or 
Letter of Cooperation

	|_|
	[bookmark: Text116]     
	|_| Attached
|_| Pending

	|_|
	     
	|_| Attached
|_| Pending

	|_|
	     
	|_| Attached
|_| Pending


*The following additional information is required: contact information for the site, if the site has an IRB, and whether the IRB has approved the research, or plans to defer review to SU’s IRB: 
[bookmark: Text117]	     

5.3. Will this research be conducted in a school or is it funded by the US Department of Education?
[bookmark: Check441]	|_|  No (Skip to 5.4)
[bookmark: Check442]	|_|  Yes. If yes, complete the form found at: 
Link - U.S. Department of Education
Note: When data will be collected in schools or is funded by the US Department of Education, the letter of cooperation must contain certain elements. A template for this letter is provided on our website at: 
Link - Letter-Of-Cooperation-Schools. 

5.4. Is this a multi-center research project in which Syracuse University will function as the coordinating 
       center/lead institution? (A multi-center study is one where different PIs at different institutions are
          	conducting the same study.)
  	|_|  No		
	|_| Yes. If yes, describe the plans to manage information obtained in multi-site research that may   
                       be relevant to the protection of research participants such as: unanticipated problems 
		          involving risks to participants or others, interim results, and protocol modifications:
          

6. Research Qualifications
CITI training is required for the principal investigator, research staff, and any other members of the research team listed in Section 1 and in Section 6 below who will have direct contact with participants and/or identifiable human participant data. Persons who will not have direct access to participants and/or identifiable participant data (e.g.-will only have access to de-identified participant data) should not be listed. Direct contact may include any recruitment activities, consent, and/or data collection.
It is important to note that the Responsible Conduct of Research (RCR) Training cannot be substituted for the Human Research CITI Training required for individuals involved in Human Subjects Research. Please consult our website for complete guidance regarding CITI training requirements: Link - Human Research - Education and Required Training or to access the CITI training website: Link - CITI Website.
Training completion will be verified by the IRB office for each person listed in this section of the application who has affiliated with Syracuse University. Copies of CITI training certificates do not need to be provided for these persons. However, if training was completed through an affiliation with an institution other than Syracuse University, copies of valid CITI training certificates must be provided with the application. 
Note: The protocol application will be reviewed but cannot be approved until all persons listed in Sections 1 or 6 of the application have completed the required Human Research CITI training appropriate to their role in the research.	
[bookmark: Text33]	
6.1. List the name and provide a brief description of the research credentials of the principal investigator listed in Section 1 of this application (4-5 sentences) including a clear explanation of their role in the research. Please provide specific references to education, teaching/professional experience, past/present research activities, publications, and/or expertise related to  the field of study and targeted population being explored. 
Include in your description a statement that verifies the required Human Research CITI training certification is currently valid for the person listed.
	      	
6.2. List the name/s and provide a brief description of the research qualifications of each member of the research staff listed in Section 1 of this application including a clear explanation of their role in the research. (For student researchers this might include any pertinent coursework, prior involvement in other research activities.)
Include in your description a statement verifying the required Human Research CITI training certification is currently valid for each person listed. 
[bookmark: Text120]	      
6.3. List the name/s and provide a brief description of the research qualifications of all other research team members who will be involved in this research including a clear explanation of their role in the research. (For student researchers this might include any pertinent coursework, prior involvement in other research activities.) Include in your description a statement verifying the required Human Research CITI training certification is currently valid for each person listed.	
     

6.4. Describe how the person listed as principal investigator will ensure that all research team members listed in this section remain informed about the protocol, their research related duties and functions, and the progress of the research. Include in your description both the method (i.e.-via email/phone/in-person/Zoom, etc.) and the frequency of the communication (i.e.-daily, weekly, bi-weekly, etc.).
     

6.5. Describe how you will have sufficient qualified staff and student support to conduct your study as proposed in Section 4.1 within the timeline as described in Section 4.2 of the application with the total number of participants indicated in Section 7.1, and why additional research staff, other than those listed in this section, are not required.
[bookmark: Text121]      
7. Characteristics of Participants				☐  N/A Data Analysis Only 
7.1. [bookmark: Text124]Approximate Number of Participants to be recruited:      
               
7.2. Age Range of Participants:      

7.3. [bookmark: Text125]If your age range includes an upper limit, justification must be provided:       
If not, please indicate |_| No.

7.4. Does this study target a vulnerable population such as children, those with decisional impairments, or prisoners? Does the study target a specific population, gender, social, or ethnic group?

 |_| No. (Skip to 7.5)
 |_| Yes. If yes, answer 7.4.1. and 7.4.2. below.
7.4.1. If yes, check all that are targeted/vulnerable populations and when appropriate provide a copy of the required form. *The forms can be found on the IRB Website under Special Populations: 
Link - Human Research Forms
|_| Children/minors - *Requires additional form* 
			|_| Decisionally impaired - *Requires additional form* 
|_| Prisoners - * Requires additional form* 
|_| Pregnant women  - *Requires additional form* 
[bookmark: Check375]|_| Legally restricted, non-prisoner
|_| Educationally disadvantaged
|_| Economically disadvantaged
|_| Elderly/aged
[bookmark: Text165]|_| Other, specify:      
		*NOTE*: These additional forms can be found on the IRB Website (under Special Populations): 
	        	Link - Human Research Forms
7.4.2. [bookmark: Text126]  Explain the rationale for using the targeted population identified above:      
7.5. Provide a simple bulleted list of all of the inclusion/eligibility criteria for participation. The inclusion criteria listed should be study specific and correspond to the study rationale/methods described in the protocol application. The list should include: age requirements, location-if the participants must be from a certain city/area/region/state/country, specific population characteristics, any type of recording-if it required and not optional, the appropriate device and access to the Internet for research conducted remotely, and any other study specific criteria that makes one eligible to participate in this study.  If more than one participant group will be included in the research, the inclusion criteria should be listed separately. What makes one eligible to participate in this research?
(N/A is an incorrect response if participants will be recruited for this study).
     

7.6. Provide a simple bulleted list of all of the exclusion/ineligibility criteria for participation. Ensure the exclusion criteria listed is study specific and corresponds to the study rationale/methods described in the protocol application. The exclusion criteria must be completely described and must mirror all of the inclusion criteria listed above. What makes one ineligible to participate in this study? 
(N/A is an incorrect response if participants will be recruited for this study).
[bookmark: Text128]     

7.7. Does this research involve participants likely to be vulnerable to coercion or undue influence? 
[bookmark: Check377]|_| No. (Skip to 7.8)  
[bookmark: Check379]|_| Yes. If yes, describe the additional protections included in the protocol to protect their rights and   
      	   welfare. 
[bookmark: Text129]	                     
7.8. General state of Health: ("Unknown"- unless you will obtain health data on participants prior to beginning the study.)  
[bookmark: Text130]     
8. Recruitment of Participants				☐  N/A Data Analysis Only
Recruitment serves as an introduction to your study and should be designed to inform potential participants about what involvement in your research entails. Consent/Assent is official agreement to participate. Not all participants recruited will agree to participate; therefore, recruitment and consent/assent cannot be combined.
Recruitment materials only need to include the following information: a statement that indicates solicitation is for research purposes; a description of the purpose of the research; all of the eligibility requirements for participation as listed in Section 7 including age range; the time commitment for participation; the location of the research; information regarding who to contact for further information; and when applicable, information regarding the incentive/compensation that is not emphasized in any manner, information regarding recording, access to the internet and appropriate device to access the study, etc. All other relevant information is included in the consent form for those who agree to participate.
Note: The researchers should not ask current participants to identify/name and/or provide private contact information of others. Instead, information regarding the research should be shared with potential participants so those interested can contact the researchers directly (i.e.-via a small card, flyer, etc.).

8.1. Describe in detail how participants will be identified and recruited. How will they learn about participation in your research? Include in your description how you will have access to a population that will allow recruitment for the number of participants required for your research. 
     

Note: If schools/departments at SU and/or outside agencies/institutions will aid with recruitment by providing researchers with private contact information of potential participants, letters of cooperation must be submitted. [A sample letter is provided on our website: Link - Letter-Of-Cooperation (General)].  Letters are not required if researchers will ask to have recruitment information forwarded on behalf of the researchers (and private contact information will not be shared with researchers). Letter/s of cooperation can be requested prior to submission of your application. Your application cannot be approved until letters from all sites listed in the application are received. Because of this, when requesting letters from multiple sites, only describe the sites for which you have letters. Additional sites can be added as amendments to your approved study as letters are received.
8.2. Will participants be recruited through a department/school/college at SU, other schools, employers, and/or community agencies or organizations where you are required to obtain permission to access data that is not publicly available? If so, a letter of support from the person authorized to give you access to the participants or the data in question must be provided. More than one letter may be required. 
|_|  Does not apply	
                |_|  Letter/s attached 
	Comments:       

8.3. Will you require support from the University for selection or contact information of participants? If so a letter of cooperation from the Office of Institutional Research (OIR) must be provided.
  |_|  Does not apply	
             |_|  Letter/s attached 
		Comments:       

8.4. Will participants be contacted through a listserv provided by a department/school/college at SU, an organization, company, or school? If so a letter of support from the individual authorized to provide you with this information must be provided.
                 |_|  Does not apply	
            |_|  Letter/s attached 
		Comments:       

8.5. Will participants be directly recruited by researchers through a classroom at SU? If so, a letter of support listing the classes/classroom to which the researchers will have access must be provided from the Dean and/or Department Chair. 
                |_|  Does not apply	
               |_|  Letter/s attached 
		Comments:       

8.6. Will participants be recruited via the internet/social media/websites/etc.? If so, you must name the sites you plan to use to post your recruitment information and verify whether permission is required to post information intended for research recruitment purposes. Verification of some sort must be provided from the site administrators when applicable (i.e.-email, screen shot, etc.). 
                |_|  Does not apply	
                |_|  Verification attached 
		Comments:       

8.7. Provide the names of the members of the research team listed in either Sections 1 or 6 who will be directly involved in the recruitment of participants. 
                 

8.8. Specify all applicable recruitment methods that will be used in the direct recruitment of participants below. All internet/social media, websites, advertising sources (i.e.-television, radio, newsprint, SU Today, etc.), and/or departmental research boards must be identified. Provide copies of all recruitment materials including flyers, posters, ads, Internet/social media/departmental research board posts, emails, letters, oral scripts for direct face-to-face and/or telephone recruitment, etc., including graphics. Clearly label all recruitment materials as to their intended use. 
     

8.9. Will participants receive an incentive/be compensated in any manner? 
|_| No. 
|_| Yes. If yes, provide the information as requested below.
Describe the incentive/method of compensation (i.e.-monetary, gift card, course credit, etc.), the amount of the incentive/compensation, and how the incentive/compensation will be awarded (per task, per session, upon conclusion of participation, etc.). If the incentive/compensation will be awarded via a raffle and/or drawing, the odds of winning must be described. 
     

Because the incentive/compensation cannot be contingent upon full participation, describe how the incentive/compensation will be awarded if the participant withdraws after beginning the study. The incentive/compensation must be pro-rated in a manner that recognizes the time and effort of the participant prior to withdrawal. For monetary compensation, the pro-rating schedule must be specified.
     

9. Informed Consent Procedures 			☐  N/A Data Analysis Only
Consent is required for all human subject participants 18 years of age or older. Assent is required for human subject participants who are minors (defined as 17 years of age or younger in New York State) or persons with diminished decision-making capability. Although you may request a waiver of the documentation of written consent/assent, i.e., oral, or electronic consent/assent, you must obtain consent/assent for all participants who will engage in your study. Final copies of all written, oral, and/or electronic consent/assent documents must be provided for IRB approval and date stamping. Informed consent/assent documents must be on official SU departmental letterhead that includes the departmental address and phone contact information in either the header or footer. 
All information included in the application regarding purpose (study rationale), procedures (methods), risks, benefits, privacy, confidentiality, recording, compensation, etc. must be consistently described in the consent/assent document as appropriate. Consent and assent form templates are located on our website at: Link - Human Research Forms 
(Note: Although parental consent and assent is required for all children up to the age of 17, the SU IRB only requires children aged 7-17 sign an assent form. A simple, age-appropriate oral assent script should be created and read to younger children.)

Must use NEW consent form templates as indicated for the type of consent you plan to use.
9.1. [bookmark: Text136]How many versions of the consent document are included with this application?      
9.2. [bookmark: Text137]How many versions of the assent documents are included with this application?      
9.3. Is more than one consent/assent document included with this application?
[bookmark: Check429]|_| No. (Skip to 9.4.) 
[bookmark: Check430]|_| Yes. If yes, follow instructions below (9.3.1 and 9.3.2).
9.3.1.   Each document should be numbered and labeled as to its purpose in either the header or footer of each document. If the study includes translated documents, they should not be numbered separately, instead translated documents should be numbered by version (e.g.-Consent Form 1-English; Consent Form 1-Translation, etc.)
9.3.2.   Create a separate log as an appendices identifying each document-i.e., Consent form 1-
   parental consent, Consent form 2-adult participant consent; Assent form 1-child assent, etc.)
9.4. Using the guidance below, indicate the type of consent you will obtain for your study (check all that apply).
9.4.1. Written Consent  |_|  (ATTACH COPY) 
Written Consent is signed documentation of consent. Written consent is required for all research conducted in-person. Researchers should retain signed copies of all consent documents for three years after the research is complete, after which they can be destroyed. 
NEW Template: Link - Written Consent Form (Template)
Provide a brief statement of what will be said when the consent process is initiated. For example, how will consent be introduced/explained to participants. (e.g.-Before we begin, I need you read this consent document. It outlines what you will be asked to do as a participant in my research, the risks, the benefits, and the protection of your rights as a research participant. If you have any questions as you read this document, please let me know. etc.).
[bookmark: Text138]     
9.4.2. Electronic Consent  |_|  (ATTACH SCRIPT) 
Electronic Consent is only appropriate for research when there is no direct contact with the participant; either in-person or remotely (i.e., via electronic surveys, etc.).
NEW Template: Link - Electronic Consent Form (Template)
9.4.3. Oral Consent  |_|  (ATTACH SCRIPT) 
Oral Consent is a request for the waiver of documentation of signed consent (written consent). Oral consent is most conducive for research conducted in situations when the collection of signatures is not practicable. Oral consent should be used for research conducted remotely using video conferencing platforms via the Internet, for phone interviews, in sensitive situations where the collection of signature is the only thing that connects the participants to the research and places them at risk of a breach of confidentiality, and/or for distinct cultural groups/communities in which signing forms is not the norm. Oral consent may also apply if participants have a low literacy level and forms must be read to them and when research is conducted in a field and the transporting of signed documents is not practicable and presents additional risk. Oral consent should be documented in the researchers’ field notes.
NEW Template: Link - Oral Consent Form (Template)
Provide the justification for the waiver of written consent: 
[bookmark: Text139]     
Provide a brief statement of what will be said when the consent process is initiated. For example, how will consent be introduced/explained to participants. (e.g.-Before we begin, I need to read this this consent document to you. It outlines what you will be asked to do as a participant in my research, the risks, the benefits, and the protection of your rights as a research participant. If you have any questions as I read this document, please let me know. etc.).
     
9.4.4.   N/A	|_|  Data Analysis Only, no consent form required.
9.5. Provide the name/s of the members of the research team listed in Sections 1 and/or 6 who will conduct the consent interview?
[bookmark: Text140]     
9.6. How will you ensure that prospective participants have sufficient time to consider whether or not to participate in your study? For example, will you send a copy of the consent form in advance so they have the opportunity to review the form prior to conducting the consent interview? If so, what method will you use? Will you explicitly inform participants they can re-schedule the consent interview if they would like more time to consider participation? If so, when, and how often?
[bookmark: Text141]      
9.7. What steps will be taken to minimize the possibility of coercion or undue influence? For example, participants should be informed/reminded they do not have to answer any questions they do not wish to answer. Also, if participants will be compensated, they should be informed payment will be pro-rated should they wish to withdraw at any time during the course of the research.  
[bookmark: Text142]      
9.8. An ASSENT statement is required for participants who cannot legally give consent themselves. This includes minors (those under the age of 18 in New York state) or persons considered to be cognitively impaired in their decision making ability.
|_|  No	 (Skip to 9.9)	
|_|  Yes (ATTACH COPY)
9.8.1. [bookmark: Text41]From whom will consent be obtained and by what means for minors, or the individuals considered to be cognitively impaired in their decision making ability? 
[bookmark: Text143]     
9.8.2.  If subjects are minors, will they still be involved in the study when they reach the age of majority (18)?
[bookmark: Check431]|_| N/A
[bookmark: Check432]|_| No
[bookmark: Check433]|_| Yes. If yes, outline your plan to re-consent these participants when they reach the age of  
                                             majority. 
[bookmark: Text144]		  	           
9.9. Will non-English speaking individuals be participants in the research? 
|_|  No (skip to Section 10)
|_| Yes   If yes, indicate how consent will be documented from non-English speaking participants?	
	      	 |_|	A translated written informed consent document in a language understandable to the participant. This should be an accurate translation of the full informed consent. (ATTACH COPY)
[bookmark: Text42]Identify the name of the individual or translation service that provided the translation of the consent document. 
[bookmark: Text145]     
[bookmark: Text43]List the qualifications of the individual or translation service that provided the translation of the consent document. 
[bookmark: Text146]			     
		 |_|	Orally, using a qualified translator to translate the English informed consent document 
			to the participant, and a translated short form in a language understandable to the participant (ATTACH COPY)
Identify the name of the individual or translation service that will provide translation for the consent process and during the conduct of the research.
[bookmark: Text147]     
List the qualifications of the individual or translation service that will provide translation for the consent process and during the conduct of the research.
[bookmark: Text148]     
[bookmark: Check440]  		|_| A signed confidentiality statement is required [link to form: Link - Confidentiality Agreement (Template)]
 
10. Potential Financial Conflict of Interest
A conflict of interest exists when any investigator or personnel listed in this research protocol’s financial interests may
reasonably be affected by research, scholarship, educational or other externally funded activity. Or, when the immediate
family* of anyone in such a role, have significant financial interests that may compromise, or have the appearance of compromising, an investigator’s professional judgment that could directly and significantly affect the design, conduct, or reporting of the research, proposed, or funded.

Federal Guidelines emphasize the importance of assuring there are no conflicts of interest in research projects that could affect the welfare of human participants. If this study involves or presents a potential conflict of interest, additional information will need to be provided to the Vice President for Research. 

The following significant financial interests must be disclosed if interest is in the sponsor of the research, or the product being tested: 

Significant Financial Interest – Anything of monetary value – aggregated for the Investigator and the Investigator’s spouse, domestic partner, and dependent children – that reasonably appears to be related to the Investigator’s institutional responsibilities including but not limited to the following:
1. Salary or other payment for services (i.e., consulting fees) that exceeded in the previous twelve months or is reasonably expected to exceed in the next twelve months $5,000.
1. Equity interests (i.e., stocks, stock options or other ownership interests) that meet the following tests:
1. exceeds $5,000 in value as determined through reference to public prices or other reasonable measures of fair market value (i.e., most recent sales price recognized by the company), or
1. constitutes more than a 5% ownership interest in any single entity.
1. Intellectual property rights (i.e., patents, copyrights, and royalties from such rights) upon receipt of income related to such rights and interests.
1. Services as an officer, director, or in any other executive position in an outside business, whether or not remuneration is received for such service.
1. Reimbursed or sponsored travel (i.e., that which is paid on behalf of the Investigator and is not reimbursed).
 
Syracuse University Policy on Conflict of Interest for Research Investigators:    
Link - SOP-032 - Institutional Conflict of Interest (COI) *Immediate family means a spouse, domestic partner, or dependent children.



10.1. Do any of the investigators or personnel listed in this research protocol, or members of the immediate   
               family of the investigators or personnel, have a financial interest associated with this study that requires    
               disclosure?
|_| No (Skip to question 10.3) 
[bookmark: Check112][bookmark: Text44][bookmark: Text149]|_| Yes; If yes, identify the individual(s):       
10.2. Has this financial interest been disclosed and managed? 
[bookmark: Check114]|_| Yes. The Office of Research Integrity and Protections will verify that a management plan is in place with the Vice President for Research.
[bookmark: Check113]|_| No. Action is required. Please contact the Office of Compliance for further information and guidance at E-mail - conflictsofinterest@syr.edu.
10.3 To your knowledge, did the University, or your School/Department receive a gift or equipment donation, or promises thereof, from commercial sponsors of this research project?
|_| No 
|_| Yes; If yes, identify the sponsor:       
Final IRB approval cannot be granted until all potential conflict matters are settled. The IRB requires a recommendation from the Vice President for Research regarding disclosure to participants and management of the conflict. 

11. Data Collection, Storage of Data, and/or Confidentiality 
Confidentiality pertains to the treatment of information that an individual has disclosed in a relationship of trust with the expectation that it will not be divulged to others in ways that are inconsistent with the understanding of the original disclosure without permission.
11.1. PRIOR TO CODING AND WHETHER IT WILL BE USED IN DATA COLLECTION/ANALYSIS:  
  Simply list the individually identifiable data you will obtain, use, or disclose others. This also includes any  
  private participant information you may use for recruitment/scheduling purposes. Examples of individually identifiable information includes: participant names, email addresses, home addresses, phone numbers, audio recordings, video recordings, photographs, IP addresses-which are automatically captured when research is conducted remotely via the Internet, or any other identifiable data that can link the participant to the data being collected. 
[bookmark: Text150]                      
11.2. Describe the following: 
a) How data will be maintained (i.e., paper, or electronic spreadsheet,  desktop computer, laptop or other portable device). 
     
b) How you will maintain data confidentiality and security (i.e.,  password  protected computer, encrypted files, locked cabinet, and office).
     
c) Who will have access to the data (i.e., research team, sponsors, consultants). Provide the names of the  
members of the research  team listed in either Sections 1 or 6 of the protocol application and/or any other persons outside of the research team who will have access to the data (i.e., sponsors, consultants, etc.).
[bookmark: Text151]     

11.3. If you will be sharing data between members of the research team and/or with others, describe how data 
  will be transferred or transmitted. If  data will be transmitted via electronic networks, describe how you 
	will secure the data while in transit. Specify whether the data you will share is identifiable. Ensure all 
	methods for data sharing are consistent with the standards set by Information Technology Services ITS  
  at Syracuse University (Link: Link - ITS Help)
     
11.4. Please provide the names of all persons with whom you will share data. This includes the members of the 
  research team listed in either Sections 1 or 6 of the  any other persons outside of the research team. 
[bookmark: Text152]     

11.5. If you plan to code the data linking to the participant, describe the method in which it will be coded. 
  Coding in this instance refers to the use of pseudonyms or the assignment of ID#’s that links identifiable 
  data to the participant. Include in your description whether there will be a key created linking the coded   
  data to the participant and if so, P provide the names of the members of the research team listed in 
  Sections 1 or 6 of the protocol application that will have access to the key to the code. 
[bookmark: Text153]       
11.6.  How have Principal Investigator (P.I.) and research team members listed in Sections 1 and 6 worked 
 together to ensure appropriate measures are in place to protect the privacy interests of the participants  
 and the confidentiality of data collected in the research design? 
      
  How will the P.I. and research team members continue to do so while the research is being conducted.
[bookmark: Text154]       
Privacy can be defined in terms of having control over the extent, timing, and circumstances of sharing oneself (physically, behaviorally, or intellectually) with others. 
11.7. Describe what provisions are in place to protect the privacy interests of participants, where “privacy   
      interest of participants” refers to the participant’s desire to limit interventions or interactions with others  and to limit access of others to their private information. The description should include: 
	a) The privacy of the location of the data collection (i.e.-private location vs. public location, a private space with a closed door the use of headphones for remote interviews conducted via the Internet etc.).
      
	b) The method of data collection (focus groups, one-on-one interviews, questionnaires/surveys, via             telephone, via identified remote Internet platforms, via email/posted mail communications, etc.).
      
	c) The type of data that will be that will be collected (i.e.-written, oral, recorded, etc.). All locations of data collection must be specified. For example, if the research will be conducted on campus, specify the location of the campus facilities/classrooms/offices. If the research will be conducted off-campus, specify the location (i.e.-home office, public spaces, community/agency spaces, etc.). 
[bookmark: Text155]		     
11.8. Will participants be recorded in any manner such as audio, video, film, still photographs? It is important to note that Internet platforms, such as Zoom/Teams, etc., automatically record both audio and video and you must address how this will be managed (e.g.-Will you use an external recording device? Will participants be asked to disable their video cameras or be offered the option to disable their video cameras? Will the researcher disable the video camera function?) 
 		      |_| No. (Skip to Section 12)		
[bookmark: Text156]|_|  Yes. If yes, specify the medium you will use:      
11.8.1.  Describe how and where the recordings/photographs will be stored. 
[bookmark: Text157]         
11.8.2.  Describe the purpose for the recordings and how they will be used. Will they be used for data 
   analysis only or will they be shared in presentations, at professional conferences/workshops or 
   in any other manner?
        
11.8.3. Name the persons listed in either Sections 1 or 6 of the application who will have access to the 
   recordings. 
        
11.8.4. How long will the recordings be kept and what is the disposition of the recordings once the 
    research is complete?
[bookmark: Text158]         
NOTE: Specific permission for each type of recording must be sought in the consent form and should be indicated at the end of the document using checkboxes (I agree to be audio recorded _Yes _No; I agree to be videotaped _Yes _No,  etc.)
12. Risk to Participants			 
12.1.   Describe in detail any possible physical, psychological, social, political, legal, economic, or other risks to      
       the participants, either immediate or long range. Risk may be minimal but never totally absent. Do not     
                 say “No Risk.”
[bookmark: Text159]        
12.2.   Describe what procedures will be used to minimize each risk you have stated above. Also, include in 
  your description the availability of medical or psychological resources that participants might require as    
  a consequence of the research, if applicable. If participants need to be debriefed at the end of the study, a 
  copy of the debriefing statement must be attached.
[bookmark: Text160]               
12.3. Does this research involve more than minimal risks to participants?
[bookmark: Check373]		      |_| No. (Skip to Section 13)		
[bookmark: Check374]|_| Yes. If yes, please provide plan for monitoring the data collected to ensure the safety of participants. (Your data safety monitoring plan must include the following: Description of who will monitor the data, what data will be monitored, how frequently will it be monitored, what analysis will be performed on the data, what decision rules (i.e. stopping rules) will be considered, if unexpected harms will be detected promptly, if an increased frequency or severity of unexpected harms will be detected promptly, if the protocol will be stopped once harms are proven to outweigh benefits.).
[bookmark: Text161]	      
13. Benefits			 
13.1. [bookmark: Text51]Describe any benefits to the participants in general. Incentives, such as course credit, payment, gift cards, entry into a raffle, etc. are considered an inducement to participate in the research and should NOT be described as a benefit.
[bookmark: Text162]       
13.2. [bookmark: Text52]Society at large.
[bookmark: Text163]       
13.3. [bookmark: Text53]Explain how the benefits outweigh the risks involved.
[bookmark: Text164]                    

A number will be assigned to your protocol. Please refer to it whenever calling or writing for information.
· All supporting documentation including list of references, consent and/or assent form(s), survey instruments, interview questions, recruitment materials, letters of support, IRB approvals from other institutions, etc. must be included with the application. 
· Applications can be submitted as an attachment to an email sent to orip@syr.edu.
· All correspondence will be directed to the Principal Investigator listed in the protocol. Other persons listed in Section 1 will be cc’d only on email correspondence.
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214 Lyman Hall
Syracuse University
Syracuse, NY 13244
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